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C-MORE Microbial oceanography lab course  
 
Background 
Microbes in the ocean are responsible for at least half of the primary productivity on Earth.  In so 
doing, they regulate the climate, produce food that supports the entire ocean ecosystem, and 
contribute to global chemical cycles.  Because of the essential roles that microbes play, it is 
important to understand what affects their growth and distribution.  In particular, nutrients have a 
profound impact on microbial productivity. 

Purpose 

1. Investigate the effects of different nutrients on the growth of marine microbes 
2. Compare/contrast two methods for measuring microbial growth 

Pre-lab preparation 
 
From the ESPERE Climate Encyclopedia, please read: 
 
The Oceans - Basics 
Unit 2 Part 1: Phytoplankton and Nutrients (pages 10-13) 
Unit 2 Part 3: Eutrophication (pages 15-17 minus the part about Europe at the end) 
 
The Oceans – Read More 
Unit 2 Part 1: Iron (pages 34-39) 
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Schedule 

Day 1 
• Introduction to microbial oceanography lecture 
• Set up lab 
• Make nutrient stock solutions 
• Collect, spike, and aliquot samples 
• Filter initial samples for chl and ATP and freeze them 

 
Day 2 

• Nutrient lecture 
• Assignment instructions 
• Hypothesis development 
• Measure chl from previous day’s filters 
• Filter samples for chl and ATP 

 
Days 3-5 

• Make visual observations 
• Extract chlorophyll and measure biomass 
• Take samples 

 
Day 6 

• Stats lecture 
• Compile, plot, and analyze data 
• Summary 
• Evaluations 

 
 
Experimental design 
 
Collect 35 liters of seawater from one site and divide it into five 7-liter portions, with extra 
nutrients added as follows: 
 
 
 

 

 

 

You will calculate the effects of the different nutrients on cell growth by collecting cells onto 
filters and measuring changes in chlorophyll and ATP over a 6 day period. 

7 L 
Control 
(nothing 
added) 

7 L 
Nitrate 

7 L 
Phosphate 

7 L 
Silicate

7 L 
Iron
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Chlorophyll analysis 

Each day of the experiment, filter the following volumes of water through 25mm Whatman GF/F 
filters.  Store filters in individual cuvettes with 3ml acetone and freeze in the dark for 24 hours.  
Once thawed, measure chlorophyll concentrations with a Trilogy Fluorometer. 

  

Control –  

 

Nitrate –  

 

Phosphate –  

 

Silicate –  

 

Iron –  

 

125 125  125 

125 125 125 

125 125 125

125 125  125 

125 125 125 
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ATP analysis 

Each day, filter 1 L from each treatment through 47mm Whatman GF/F.  Boil filters in 5mL 
TRIS buffer for 5 minutes and then freeze for later analysis using the firefly bioluminescence 
reaction in a photometer. 

 

Control –  

 

 

 

Nitrate –  

 

 

Phosphate – 

 

 

 

Silicate – 

 

 

 

  Iron –  

 

Record chlorophyll measurements each day (take all ATP measurements on the morning of the 
last day) and collect all of your data on a single data sheet.  Graph the data to see how the 
microbes responded to the added nutrients. 

1 L 

1 L 

1 L 

1 L 

1 L 
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Samples of testable hypotheses – you are encouraged to come up with your own! 

1. There will be no differences in biomass over time among the different nutrients. 
a. Observation: same slope, same y-intercept for all treatments 
b. Rationale: all of the nutrients are required by some organism for growth, therefore 

all of them will result in increased biomass over time  
2. Nitrate will produce the greatest change in biomass over time 

a. Observation: Either steeper slope with same y-intercept or same slope with higher 
y-intercept for nitrate compared with other treatments 

b. Rationale: More nitrate is required by organisms than any other nutrient 
3. Iron will produce the greatest change in biomass over time 

a. Observation: Either steeper slope with same y-intercept or same slope with higher 
y-intercept for iron compared with other treatments 

b. Rationale: Most iron in the ocean is not bioavailable and is therefore more 
limiting than the other nutrients 

4. There will be no difference in biomass over time between the different methods 
a. Observation: same slope, same y-intercept for both chl and ATP 
b. Rationale:  It’s possible that phytoplankton dominate the community and that 

heterotrophic organisms make a negligible contribution to biomass (though highly 
unlikely!) 

5. More biomass will be detected with ATP than with chl 
a. Observation: Higher y-intercept for ATP than chl 
b. Rationale: ATP measures both heterotrophic and phototrophic biomass, while chl 

only measures the latter 
6. The phytoplankton community will respond more to the added nutrients than the 

heterotrophic community 
a. Observation: The slope for chl a will be steeper than the ATP slope 
b. Rationale: There is a lag in response time for heterotrophs because nutrients have 

to be incorporated into the phytoplankton community before having an effect on 
heterotrophic organisms. 
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Chlorophyll data analysis 
 

1. Open the Excel file named “data” on your desktop. 
2. At the bottom of the screen, click on the tab “Chl a”. 
3. In column H, calculate the biomass for each treatment by multiplying the mean [chl] by 

60 (the carbon to chlorophyll conversion factor). 
4. In column M, calculate the mean biomass for each time period of each treatment using 

the “AVERAGE” option in the drop down menu on the upper left of the screen. 
a. For example, in cell M3, enter “=” then click on “AVERAGE”.  On the datasheet, 

highlight cells H4-H6 and press “OK” in the pop-up box. 
b. MAKE SURE TO TRANSFER THE CORRECT DATA INTO THE BIOMASS 

TABLE! 
5. Similar to the mean biomass, calculate the standard deviation in column N by using the 

“STDEV” option in the drop down menu. 
6. Plot the data for the Control by highlighting columns K and L, rows 2-9.   

a. Go to Insert > Chart > XY (Scatter). Select the bottom right chart subtype 
(“Scatter with points connected by lines”) and click Next. 

b. Click Next, again. 
c. Give your graph an informative title. 
d. Label your axes and click Next. 
e. Save your graph as a new sheet and name it. 
f. Click Finish. 

7. Add the data from the other treatments to this graph. 
a. Right click on the graph. 
b. Select Source Data… 
c. Click Add. 
d. In the Name field, label the data by treatment, e.g. Nitrate 
e. To add data to the x-axis, click on the small red and blue table icon to the right of 

the X Values field. 
f. Click on the “Chl a” tab at the bottom of the screen to access the data. 
g. Highlight the x-axis data for Nitrate (column K, rows 10-16) and click on the 

small table icon again. 
h. To add data to the y-axis field, click on the icon to the right of the Y Values field. 
i. Delete {1} so that there is just an equals sign and click on the “Chl a” tab. 
j. Highlight the y-axis data for Nitrate (column L, rows 10-16) and click on the table 

icon again. 
k. Repeat step 6c – 6j to and enter data for the remaining 3 treatments using the 

appropriate data cells. 
l. Click on biomass in the Series field and then type “Control” (incl. quotes) after 

the = in the Name field. 
m. Hit OK. 

8. Add error bars to your curves: Click on a curve and go to Format>Selected data series… 
a. Select the Y error bars tab, choose to Display Both, and then click on Custom. 



    Kim Weersing, C‐MORE 05/08 

 

b. Highlight the appropriate standard deviations that you calculated for that curve.  
Enter these same standard deviations for the second field. (These are your + and – 
values for your standard deviation). 

c. For example, for the Control: after you have done step 8a, highlight cells N3-N9.  
Click on the second field and highlight the same cells.  Click OK and the error 
bars should be added to the Control curve. 

 
ATP data analysis 
 

1. Click on the tab “ATP” 
2. In column E, calculate the ATP concentration using the standard curve where: 

a. ATP = [(RLU-intercept)/slope] 
3. In column K, calculate the biomass for each time period of each treatment by multiplying 

the mean [ATP] by 250 (the carbon to ATP conversion factor). 
a. MAKE SURE TO TRANSFER THE CORRECT DATA INTO THE BIOMASS 

TABLE! 
4. Plotting the ATP biomass data is the same as for chlorophyll 
5. Plot the data for the Control by highlighting columns J and K, rows 3-10.   

a. Go to Insert > Chart > XY (Scatter). Select the bottom right chart subtype 
(“Scatter with points connected by lines”) and click Next. 

b. Click Next, again. 
c. Give your graph an informative title. 
d. Label your axes and click Next. 
e. Save your graph as a new sheet and name it. 
f. Click Finish. 

6. Add the data from the other treatments to this graph. 
a. Right click on the graph. 
b. Select Source Data… 
c. Click Add. 
d. In the Name field, label the data by treatment, e.g. Nitrate 
e. To add data to the x-axis, click on the small red and blue table icon to the right of 

the X Values field. 
f. Click on the “ATP” tab at the bottom of the screen to access the data. 
g. Highlight the x-axis data for Nitrate (column J, rows 11-17) and click on the small 

table icon again. 
h. To add data to the y-axis field, click on the icon to the right of the Y Values field. 
i. Delete {1} so that there is just an equals sign and click on the “ATP” tab. 
j. Highlight the y-axis data for Nitrate (column K, rows 11-17) and click on the 

table icon again. 
k. Repeat step 6c – 6j to and enter data for the remaining 3 treatments using the 

appropriate data cells. 
l. Click on biomass in the Series field and then type “Control” (incl. quotes) after 

the = in the Name field. 
m. Hit OK. 
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Data interpretation 
 

1. For each of the biomass measurement methods, describe the shapes of the curves for the 
different treatments.   

a. How do the curves differ from each other?    
2. How do the chl a curves differ from the ATP curves? 

a. Try graphing the chl and ATP data on the same graph for the different treatments 
(i.e. graph data from just the silicate treatment but for both chl and ATP).   

3. How do the results compare with your hypothesis? 
4. How could this experiment be improved? 
5. What other questions would be interesting to consider in future studies?  How would you 

go about investigating/answering them? 
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Formal Laboratory Report 

Length:  8 pages, double spaced, 12-font, 1-inch margins 

The following outline provides some ideas for the content of your lab report.  Your report may 
vary from this format depending on the nature of your hypothesis.  Feedback will be provided on 
your rough draft to help direct your final draft; however, you need to make your rough draft as 
complete as possible (i.e. a rough draft is not an outline!) 
 

I. Title (* pts) 
a. Please do not have a separate title page or table of contents 
b. Should be informative and catchy, e.g. Bring home the bacon!: A history of feral 

pig hunting in Hawaii (whereas a title like “Nutrient study” is too short and does 
not tell you what about nutrients you studied) 

 
II. Introduction (* pts): ~1 page 

a. Present any background information: why is this topic important? 
b. Clearly state the main objective(s) of your study or the issue that your study 

addresses 
c. What is your hypothesis? 

 
III. Methods (* pts): ~1 page 

a. Clearly describe what you did so that anyone who reads your report can repeat 
your experiment.  This is a critical aspect of science – if no one else can replicate 
your results, then they will be dismissed as being false! 

b. It may be helpful for your reader to include a table of the experimental design 
 

IV. Results (* pts): 1-2 pages 
a. Summarize your results without interpreting them 
b. Put any graphs, tables, or figures in this section 
c. Write an informative caption for every graph, table, or figure 

 
V. Discussion (* pts): 2-3 pages 

a. Interpret and discuss your results 
b. Did your results support your hypothesis?  Why or why not? 
c. How do your results address the questions/issues that you presented in the 

introduction? 
d. Offer suggestions for improvement or ideas for future research 
e. Feel free to use sub-headings other than “Discussion” if it helps the flow/clarity of 

your paper 
 

VI. Conclusion (* pts): ½-1 page 
a. Summary of your main finding(s) 
b. Take home message(s) 
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VII. References (* pts): ½ page 
a. This is one of the most important aspects of scientific papers…you must give 

credit to your source of information!  Please reference within the body of your 
paper all thoughts/ideas that are not your own (most of the sentences in your 
introduction will likely need a reference!).  At the end of a sentence, reference 
within parentheses the author and date of publication (or the name of the website 
and date).  E.g. Hydrogen peroxide is a metabolic intermediate formed during 
normal cell respiration and enzyme reactions (Moller 2001). 

b. Use at least 5 references 
c. For books and articles, include the author, date of publication, title, name of 

publication, page numbers. 
d. For internet sources, state the web address as well as the date that you accessed it.  

Include the author’s name if possible. 
Expectations: 

I am looking for clear, straight-forward writing that demonstrates your understanding of the 
material and the ability to pull together information from a number of different sources.  The 
report should have a logical flow with parallel construction (i.e. If your introduction states that 
you’ll be discussing intertidal ecology in terms of adaptations to physical, biological, and 
chemical stresses, then the body of your paper should follow the same order: physical, 
biological, and chemical stresses). 



    Kim Weersing, C‐MORE 05/08 

 

Glossary 
 
Eukaryote – any organism whose cells possess a nucleus and membrane-bound organelles.  This 
group is represented by animals, plants, fungi, and protists.  Reproduction occurs via meiosis and 
mitosis. 
 
Prokaryote – mostly single-celled organisms that lack a nucleus or any other membrane-bound 
organelle. 
 
Remineralization – the process that occurs during digestion of tissues or cells in which organic 
compounds are converted into inorganic molecules. 
 
Plankton (from the Greek “planktos” which means “wanderer” or “drifter”) 

• Phytoplankton – small, generally unicellular, aquatic organisms capable of  
photosynthesis.  This group includes some types of: algae, bacteria, and protists. 

• Zooplankton – any aquatic heterotrophic organism that is incapable of swimming 
against a current. 

 
Micrometer (also micron) – one-millionth of a meter.  To visualize this size, a dime is about 1 
millimeter thick.  If you sliced a dime into 1,000 layers of equal thickness, each slice would be 1 
µm (micron).  To see the relative sizes of cells, go to: 
http://upload.wikimedia.org/wikipedia/commons/0/01/Relative_scale.svg 
 
Organic carbon (= organic matter = fixed carbon) - matter which was once part of a living 
organism or produced by a living organism and is capable of decay. 
 
Archaea – an ancient group of prokaryotic, unicellular organisms that are superficially similar to 
bacteria but are actually more closely related to eukaryotes.  These cells can be found in the most 
extreme environments, including acidic water, boiling hot geysers, and freezing cold glaciers! 
 
Bacteria (singular: bacterium) – unicellular microorganisms that have a wide diversity of shapes 
and metabolic abilities (for example, some bacteria are aerobic and use oxygen as an e- acceptor, 
while others are anaerobic and live in the absence of oxygen.  Anaerobic bacteria instead use 
nitrate, sulfate or CO2 as e- acceptors).  These different ways of obtaining energy allow bacteria 
to inhabit a broad range of habitats, ranging from cow intestines to deep-sea hydrothermal vents.  
Bacteria are not only found everywhere, but they exist in huge numbers – there are 10 times as 
many bacterial cells as human cells in the human body!! 
 
Cyanobacteria – a group of aquatic, photosynthetic bacteria that have the oldest known fossils 
(over 3.5 billion years old!).  These bacteria have contributed enormously to life on earth – they 
created our oxygen atmosphere and some became the chloroplasts that allow terrestrial plants to 
photosynthesize. 
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Protista – a diverse group of eukaryotic organisms that are not plant, animal, or fungi but can 
have either plant-like or animal-like qualities.  They are generally unicellular, but some are very 
simple multicellular organisms without specialized tissues. 
 
Virus – an infectious agent that is unable to grow or reproduce outside of a host cell.  Viruses are 
less than 1 micrometer and can only be seen with electron microscopes! 
 
Zooxanthellae – photosynthetic, unicellular algae (usually dinoflagellates) that live symbiotically 
within the cells of marine animals, such as corals, giant clams, and jellyfish.  These are the cells 
that give corals their bright colors – coral bleaching is actually caused by the loss of 
zooxanthellae from the coral. 
 
Common eukaryotic phytoplankton: 

• Diatom – one of the most common types of phytoplankton that are unique in 
possessing a cell wall made up of silica – they literally live in a glass house! 

• Dinoflagellate – a photosynthetic protist that possesses two flagella for propulsion 
and steering.  Dinoflagellates play various ecological roles - some are symbiotic 
in coral cells (=zooxanthellae), while others can be parasitic or cause toxic algal 
blooms (e.g. red tide). 

• Coccolithophore – single-celled algae that are covered in distinctive plates made 
up of calcium carbonate. 

 
Common protozoan zooplankton: 

• Radiolarians – amoeboid protozoa (animal-like protists) that produce intricate 
mineral skeletons (usually made of silica) and often possess zooxanthellae.   

• Foraminiferans – amoeboid protozoa with fine strands of cytoplasm that branch 
and form nets.  These single-celled organisms produce a calcium carbonate test 
(shell) that may have one or more chambers in which they may house symbiotic 
algae and cyanobacteria. 

 
Feeding types: 

• Autotrophy (literally: self-feeding) – the ability to be self-sustained by producing 
food from inorganic compounds.  These organisms are the primary producers.  
Different types of autotrophy include photoautotrophy (= photosynthesis) and 
chemoautotrophy (in which inorganic compounds are oxidized without sunlight to 
yield energy). 

• Heterotrophy (literally: other feeding) – an organism that requires organic matter 
as its carbon source for growth and development.  These organisms are the 
consumers in a food web. 

• Mixotrophy – organisms that are capable of deriving energy from both 
photosynthesis and external energy sources.  In well-lit, nutrient-rich 
environments, they can photosynthesize, while in food-rich or dark conditions, 
they can feed on other organisms.  Almost all of these organisms are protists. 
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Nutrients: 
• Nitrate (NO3) – nitrate is the most usable form of nitrogen in the ocean.  The 

primary source of nitrate is leaching from dissolved rocks and minerals and 
subsequent transport to the ocean by rivers.  However, some nitrate is recycled 
into the euphotic zone by upwelling or generated by nitrogen-fixing microbes.  
Nitrogen is an essential component of proteins, amino acids, and DNA. 

• Phosphate (PO4) – phosphate is also transported to the ocean by rivers and is 
incorporated into cell membranes and ATP. 

• Iron (Fe) – iron is called a micronutrient because it is only required in small 
amounts; however it is essential for life.  In phytoplankton, iron is required by the 
enzyme complex that converts light energy into chemical energy.  It is also used 
by another enzyme that enables the cell to use NO3. 

• Silicate (SiO3) – silica is very valuable to diatoms, which use it to build an 
external skeleton that helps protect them from being grazed by zooplankton. 

 
Eutrophication – an increase in the nutrient concentration (typically of nitrogen or phosphorus) 
in an ecosystem.  Eutrophication is frequently the result of nutrient pollution due to agricultural 
or urban run-off into streams and coastal waters.  This pulse of nutrients often results in algal 
blooms which can have variable effects on the ecosystem. 
 
(Eu)photic zone – the portion of the water that receives enough sunlight for photosynthesis to 
occur.  The euphotic depth is the depth at which the light intensity is 1% of that at the surface. 
 
Chlorophyll – a green, light-absorbing pigment that is vital for photosynthesis. 
 
Primary production – the production of organic compounds from atmospheric and aquatic carbon 
dioxide.  Primary production can also be thought of as the production and growth of autotrophs.  
All life on earth relies on primary production, which is the base of the food web. 
 
Algal bloom – a rapid increase in the population of algae in an aquatic system.  Algal blooms can 
be welcome sources of food for coastal communities of zooplankton, fish, marine mammals, and 
seabirds, but they can also be detrimental.  Blooms of toxic dinoflagellates can be consumed by 
shellfish and cause paralytic shellfish poisoning in humans, or blooms can impact coral reef 
ecosystems by blocking out light needed for photosynthesis.  Additionally, the consumption and 
degradation of abundant algal cells can lead to anoxic zones of the water that can literally 
suffocate resident organisms. 
 


